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Kapitola 1

Úvod

V gra�ckém prost°edí REXYGEN Studio vytvá°íte algoritmy pomocí rozsáhlé knihovny
funk£ních blok· systému REXYGEN [1]. K dispozici jsou jak jednoduché komparátory
a £asova£e, tak pokro£ilé bloky pro zpracování analogových signál· a regulaci. Nechybí
ani PID regulátory s automatickým lad¥ním parametr·. Va²e algoritmy m·ºete ihned
p°eloºit a spustit na cílovém za°ízení (Linux IPC, WinPAC, Raspberry Pi atd.). P°i b¥hu
výsledného algoritmu m·ºete v reálném £ase sledovat v²echny signály a funk£ní bloky.
P°ipojení je moºné v lokální síti i p°es Internet.

K celému systému REXYGEN je k dispozici rozsáhlá dokumentace, tu lze vyvolat
stiskem klávesy F1. V základním nastavení instalátoru vývojových nástroj· °ídicího sys-
tému REXYGEN je dokumentace zahrnuta p°ímo v instalaci. Pokud uºivatel dokumentaci
z instalace vy°adil, pak není dokumentace k dispozici. �e²ením je pak op¥tovná instalace.

1.1 Spu²t¥ní REXYGEN Studio

Program REXYGEN Studio lze spustit bez jakýchkoliv parametr· a to prostým dvojklikem
na ikonu REXYGEN Studio. Program se skládá ze £ty°ech £ástí: hlavní menu (1), toolbar
(2), pracovní plocha (3) a statusbar (4). Na pracovní plo²e m·ºe být umíst¥no n¥kolik
soubor· zárove¬. U neuloºeného souboru se v záhlaví vedle názvu zobrazuje hv¥zdi£ka.

1.2 Pracovní plocha editoru

Do pracovní plochy editoru se umís´ují jednotlivá okna se soubory projektu. Soubory
mají p°íponu .mdl. Tato okna mohou být libovoln¥ rozmíst¥na po pracovní plo²e, p°í-
padn¥ lze okna rozmístit pomocí záloºky z menu "Windows"a to kaskádovit¥ nebo pod
sebe. V kaºdém okn¥ je podpo°en zoom, který umoº¬uje p°iblíºit resp. oddálit schéma.
Zm¥na p°iblíºení/oddálení se provádí rotací kole£ka my²i p°i stisknuté klávese Ctrl. Dal²í
moºností, jak zm¥nit velikost p°iblíºení/oddálení pracovní plochy, je vyuºít Zoom in £i
Zoom out z menu View £i z toolbaru (dokovacího panelu rychlého p°ístupu). V poslední
°ad¥ lze pouºít klávesové zkratky F2/F3.

3



Obrázek 1.1: Úvodní obrazovka REXYGEN Studio

1.3 Pracovní reºimy vývojového prost°edí

REXYGEN Studio nabízí dva reºimy: návrhový reºim a reºim sledování (tzv. Watch re-
ºim). Algoritmy jsou vyvíjeny v návrhovém reºimu kreslením diagram· funk£ních blok·
na plátn¥ a kon�gurací parametr· funk£ních bloku. Aplikace m·ºe nebo nemusí být
p°ipojena k cílovému za°ízení.

Po p°ipojení k cílovému za°ízení m·ºe být REXYGEN Studio p°epnuto do reºimu sle-
dování. V reºimu sledování nelze vyvinutou aplikaci zm¥nit. Místo toho slouºí schéma s
funk£ními bloky jako diagnostické rozhraní k b¥ºícímu algoritmu. Uºivatel m·ºe kontro-
lovat v²echny signály, parametry, trendy a a provád¥t podrobnou diagnostiku algoritmu
b¥ºícího na cílovém za°ízení.

1.4 Hlavní menu

1.4.1 File

Tato nabídka zp°ístup¬uje akce, které se váºí k soubor·m vytvá°eným v aplikaci.

• Start: Otev°e dialog a nabídne uºivateli n¥kolik moºností jak za£íst vyvíjet °ídicí
algoritmy s REXYGEN Studio. Volba je k dispozici pouze pokud není otev°en ºádný
projekt.

• New: Vytvo°ení nového souboru

• Open: Otev°ení souboru
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• Close: Uzav°ení souboru

• Close All: Uzav°ení v²ech otev°ených soubor·

• Save: Uloºení souboru

• Save as: Uloºení souboru pod jiným jménem

• Save all: Uloºení v²ech otev°ených soubor·

• Start with a Plain Project: Vytvo°í a otev°e nový prázný projekt.

• Start from an Example Project: Otev°e dialog, ve kterém si uºivatel m·ºe vybrat
z jiº existujících ukázkových p°íklad·. Vybraný ukázkový p°íklad je zkopírován do
uºivatelem zadaného adresá°e a otev°en. Uºivatel m·ºe takto za£ít vyvíjet vlastní
°ídicí algoritmus modi�kováním jiº existujícího ukázkového p°íkladu.

• Open Project from Target Device: Od verez REXYGENu 2.50.4 je podporováno
uloºení zdrojových soubor· projektu na cílové za°ízení. Uºivatel m·ºe pomocí této
volby uloºený projekt na£íst, uloºit do svého po£íta£e a otev°ít v REXYGEN Studio.

• Export: Export aktuálního okna do SVG formátu

• Set as Project Main File: Nastaví aktuáln¥ otev°ený soubor jako hlavní projektový
soubor. V hlavním souboru projektu by m¥l být vºdy p°ítomen blok exekutivy.

• Save Project as: Zkopíruje aktuáln¥ otev°ený projekt do uºivatelem zvoleného ad-
resá°e, uzav°e aktuální projekt a znovu jej otev°e z nového umíst¥ní.

• Print: Tisk

• Print Preview: Náhled tisku

• Print Setup: Nastavení tisku

• "Naposledy otev°ené soubory" Seznam pouºívaných soubor·

• Exit Ukon£ení aplikace

1.4.2 Edit

• Undo: Zru²ení poslední akce

• Redo: Otev°ení souboru

• Select All: Výb¥r v²ech komponent v aktivním okn¥

• Cut: Vyjmutí

• Copy: Kopírovat vybraný(é) blok(y)
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• Paste: Vloºit kopírovaná(é) blok(y)

• Properties: Vlastnosti vybraného bloku

• Declaration of Parameters: Deklarace parametr· subsystému

• Open Subsystem: Vstup do subsystému pro monitorování nebo editaci

• Create subsystem: Vytvo°ení subsystému z vybraných blok·

1.4.3 View

Tato nabídka zp°ístup¬uje akce, které se váºí k nastavení zobrazení pracovní plochy,
prací s lupou a s knihovnou funk£ních blok·.

• Toolbar: Zobrazení/skrytí toolbaru

• Statusbar: Zobrazení/skrytí statusbaru

• Zoom in: P°iblíºení

• Zoom out: Oddálení

• Zoom to 100 : Základní zobrazení 100

• Zoom to �t: Zobrazení výkresu do celého okna - maximální velikost

• Block Library: Otev°ení knihovny blok·

• Block Library on top: Zobrazení okna knihovny blok· vºdy nad ostatními okny

• Compile window: Zobrazení okna se zprávami p°eklada£e

1.4.4 Project

Tato nabídka zp°ístup¬uje akce, které se váºí k p°ekladu projektu, nahrání do cílového
za°ízení a monitorování signál·.

• Compile: P°eklad projektu do binárního formátu

• Compile and Download: P°eklad projektu do binárního formátu a nahrání do cílo-
vého za°ízení.

• Activate Watch Mode: Aktivuje reºim Watch. Pokud dosud nebylo vytvo°eno spo-
jení s cílovým za°ízením, je otev°en p°ipojovací dialog.

• Watch Selection: Monitorovat parametry aktuáln¥ vybraných blok·

• Exclude from Watch: Vypnout monitorování aktuáln¥ vybraných blok·

• Signals to Watch: Pokro£ilé monitorování signál· a parametr·
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1.4.5 Target

Tato £ást menu obsahuje akce, které slouºí pro správu online monitorování cílového za°í-
zení (p°ipojení/odpojení cílového za°ízení). N¥které akce jsou dostupné aº po p°ipojení
k cílovému za°ízení.

• Connect: P°ipojení k danému cílovému za°ízení

• Disconect: Odpojení od daného cílového za°ízení

• Show System log: Zobrazení záznam· chyby, varování atd.

• Con�gure System Log: Kon�gurace chybových výpis·.

• Diagnostics: Spu²t¥ní diagnostického nástroje

• Change password: Zm¥na hesla k cílovému za°ízení

• Licencing: Informace o licencích

1.4.6 Tools

Zp°ístup¬uje dal²í nástroje.

• REXYGEN Diagnostics: Diagnostický nástroj REXYGEN Diagnostics

• Cam Editor: Editor va£kových pro�l· / k°ivek

• SFC Editor: Editor pro stavové automaty

• REXYGEN HMI Designer: Nástroj pro návrh vizualizace a ovládacího rozhraní
£lov¥k-stroj (HMI)

1.4.7 Settings

V této £ásti menu lze nastavit parametry online monitorování, (jednak rychlost obnovy
£tených/zapisovaných dat) a nastavit formát zobrazovaných £ísel. Dále lze nastavit vlast-
nosti tisku a moºnost automatického otev°ení posledn¥ otev°eného projektu p°i spu²t¥ní
REXYGEN Studio.

1.4.8 Window

Tato £ást menu obsahuje funkce pro zobrazení oken

• Cascade: Kaskádovité zobrazení jednotlivých oken

• Tile: Zobrazení oken v °ádcích pod sebou

• Arrange Icons: Zarovnání minimalizovaných oken
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1.4.9 Help

• Function blocks manual: Nápov¥da k funk£ním blok·m

• Examples: Sloºka s ukázkovými p°íklady

• Documentation: Dokumentace k systému REXYGEN

• About REXYGEN Studio: Informace o programu REXYGEN Studio (verze)
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Kapitola 2

Funk£ní bloky

V²echny funk£ní bloky systému REXYGEN jsou popsány v referen£ní p°íru£ce [1].

2.1 P°idání blok· do schématu

V²echny bloky, které je moºné p°idat do schématu, naleznete knihovn¥ funk£ních blok·
(View/Block Library nebo Ctrl+L). Bloky jsou rozd¥leny do n¥kolika logických skupin
- rozbalovací nabídka Library. Bloky lze v knihovn¥ vyhledávat zadáním názvu (nebo
jeho £ásti) do pole Block. Pokud je vybrána konkrétní knihovna, vyhledávání probíhá
pouze v této vybrané knihovn¥! Bloky do schématu p°idáme prostým p°etáhnutím z
Block Library na poºadovanou pozici ve schématu (táhnout lze bu¤ název bloku nebo
p°ímo jeho symbol z pravé £ásti okna knihovny).

2.1.1 Nápov¥da k funk£ním blok·m

Nápov¥du k danému bloku lze vyvolat dv¥ma zp·soby. Nejprve vybereme kliknutím
levého tla£ítka my²i poºadovaný blok a poté stiskneme klávesu F1. Dojde k otev°ení
HTML dokumentace ve webovém prohlíºe£i. Pokud dokumentace HTML není nalezena,
otev°e se referen£ní p°íru£ka ve formátu PDF na úvodní stran¥ (poºadovaný blok musí být
ru£n¥ dohledán). Druhou moºností je stisknout pravé tla£ítko na daném bloku a vybrat
moºnost Help. Nápov¥du lze vyvolat v libovolném míst¥ programu stiskem klávesy F1,
£ímº dojde k otev°ení úvodní strany s nápov¥dou.

2.2 Editace vlastností blok·

V²echny vlastnosti blok· (vyjma velikosti bloku a pozice bloku) lze editovat z menu
Edit/Properties, klávesovou zkratkou Ctrl+E nebo prostým dvojklikem na blok. Velikost
bloku se edituje p°ímo v hlavním okn¥, vybráním daného bloku a posléze taºením za vy-
braný roh bloku. Vybraný blok lze p°emístit taºením my²í nebo kurzorovými ²ipkami na
klávesnici.

Editovat lze:
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Obrázek 2.1: Knihovna funk£ní blok·

• Jméno bloku

• Záloºka Parameters: v²echny parametry bloku

• Záloºka Runtime: chování bloku na cílovém za°ízení

• Záloºka Style: velikost, font, barvu, barvu pozadí, orientaci bloku

2.3 Spole£né vlastnosti blok·

V p°ípad¥ editace více blok· zárove¬ lze editovat pouze vzhled blok· (karta Style).
Ostatní parametry je nutné editovat u kaºdého bloku zvlá²´.

Editace se provádí vybráním poºadovaných blok· bu¤ taºením my²i p°es dané bloky
se stisknutým pravým tla£ítkem nebo vybíráním blok· levým tla£ítkem my²i se stisknu-
tou klávesou Shift.

Hromadnou zm¥nu blok· nelze vyvolat poklikáním na vybrané bloky, je nutné pouºít
Ctrl+E £i poloºku menu Edit/Properties.

2.3.1 Spojení blok·

Bloky se propojují pomocí vstupních a výstupních pin·. Samotné propojení se provádí
tahem my²i. Ve chvíli, kdy se pin uchopí a je taºen mimo svou pozici, dojde k vytvo°ení
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Obrázek 2.2: Vlastnosti bloku

spojnice, která drºí pravoúhlé zalomení a sleduje pozici kurzoru. Pokud se takto vytvo°e-
nou spojnici p°iblíºíte do okolí pinu, který je vhodný pro p°ipojení, spojnice se zvýrazní
(zelená barva, tu£ná £ára). Po uvoln¥ní tla£ítka se spojnice napojí na pin. Spojnici lze
libovoln¥ zalamovat (p°i stálém drºení pravoúhlého zalomení). Zalomit spojnici lze tak,
ºe nejprve vytvo°íme první £ást spojnice, po uvoln¥ní levého tla£ítka my²i op¥t ucho-
píme koncový vrchol spojnice p°i stisknuté klávese Ctrl nebo pravým tla£ítkem my²i,
p·vodní spojnice op¥t zezelená, vytvo°í se nám dal²í £ást spojnice. Tento postup lze
libovoln¥ opakovat, poslední £ást spojnice se napojí na p°íslu²ný pin. U vytvo°ené spoj-
nice lze tahat libovolné úse£ky a libovolné vrcholové body (Obrázek 2.2). Spojnici lze po
ozna£ení (kliknutí levým tla£ítkem) smazat pomocí klávesy Delete. Odpojení spojnice
od pinu se provádí kliknutím pravým tla£ítkem na spojnici v blízkosti p°íslu²ného pinu
a zvolením Break/Disconect line.

2.4 Persistent memory

Systém REXYGEN podporuje trvalé ukládání parametr· funk£ních blok· a n¥kterých
jejich vnit°ních stav·. Trvalá pam¥´ je závislá na zvolené cílové platform¥. Pokud cílová
platforma neobsahuje ºádnou podporovanou trvalou pam¥´, jsou parametry ukládány na
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Obrázek 2.3: Spojnice mezi bloky

disk defaultn¥ do souboru permem.dat (do stejného adresá°e, kde se nachází exec.rex-
\rex\rexcore na Linux za°ízeních nebo C:\ProgramData\REXControls\REX_<version>
\RexCore\ na Windows).

Pomocí kon�gura£ního souboru rexcore.cfg lze nastavit velikost trvalé pam¥ti, ná-
zev souboru a jeho umíst¥ní. Více informací v dokumentaci k RexCore [2].

Pro trvalé uloºení paramatr· funk£ních blok· za²krtn¥te checkbox Permanent v Block
properties - viz Obr. 2.2. V²echny parametry funk£ního bloku a n¥které vnit°ní stavy
bloku budou trvale uloºeny (krom¥ polí) Seznam intern¥ vybraných vnit°ních stav·
funk£ních blok·:

• INTE

• SINT

• COUNT

• SHIFTOCT

• OSD

• SHLD

• DIF_

• TIMER_

• ABSROT

• E/ATMT
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Defaultní ukládací perioda je 300 s, defaultní velikost pam¥ti je 10240 byte.
Trvalá pam¥´ m·ºe být vymazána nebo vy£i²t¥na pomocí Download Dialogu - viz

Obr. 3.1. P°epn¥te Download option v Download Dialogu na Expert mode a vyberte
Reset persistent memory nebo Cleanup persistent memory. Reset persistent memory

nahradí kompletní trvalou pam¥´ naproti tomu Cleanup persistent memory vymaºe
pouze parametry, které se uº není t°eba trvale ukládat.

P°i vým¥n¥ exekutivy dojde k p°epsání parametr· funk£ních blok· t¥mi jiº d°íve ulo-
ºenými, pokud je u daného funk£ního bloku aktivována moºnost Permanent.
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Kapitola 3

P°eklad, nahrání a diagnostika
projektu

Celý projekt je nutné pomocí p°eklada£e REXYGEN Compiler p°eloºit do binárního kon-
�gura£ního souboru *.rex a nahrát do cílového za°ízení. Ob¥ tyto akce lze provést p°ímo
z kon�gura£ního nástroje REXYGEN Studio.

3.1 P°eklad projektu

Pro p°eklad vytvo°eného projektu slouºí p°íkazy z menu Project. Projekt m·ºeme bu¤
pouze p°eloºit nebo lze zárove¬ s p°ekladem provést i nahrání tzv. exekutivy do cílo-
vého za°ízení. P°i spu²t¥ní p°ekladu se vypisují informace o p°ekládaných souborech a
p°ípadn¥ i výskyt chyb p°ekladu. Pokud je detekována závaºná chyba, ukon£í se p°eklad
kon�gurace a nevytvo°í se výsledný binární soubor.

Volba Store con�guration permanently je nutná k uloºení kon�gurace projektu na
cílovém za°ízení, aby se automaticky na£etla p°i jeho spu²t¥ní (nap°. po restartu, zapnutí,
výpadku napájení, atp.).

3.2 Aktivace licence

P°ed p°ekladem projektu je nutné aktivovat licenci. Aktivaci provedete následujícím
zp·sobem. V hlavního menu vyberte moºnost Target a zvolte hned první moºnost Con-
nect/Watch £i klávesová zkratka F7. Zde je nutné vyplnit Target, adresu cílového za°ízení
nap°íklad 192.168.1.1, localhost atd. Uºivatelské jméno admin, heslo ponechte prázdné
a zvolte Connect.

Vysko£í na vás okno s výb¥rem t°í moºností (Obrázek 3.2):
Get DEMO Licence: Nutné vyplnit registra£ní formulá°, demo licence bude doru£ena

do va²í emailové schránky - obrázek 3.3.
I already have a licence: Zadání licence - zakoupená £i demo licence - obrázek 3.4.
Continue: Pouze p°ipojení k targetu bez platné licence.
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Obrázek 3.1: P°eklad a nahrání exekutivy

3.3 Online monitorování a diagnostika

Nástroj REXYGEN Studio disponuje i reºimem tzv. online monitorování. V n¥m je moºné
upravovat parametry b¥ºícího °ídicího algoritmu. V záloºce v hlavním menu naleznete
moºnost Target (Connect/Watch, Disconnect). Po p°ipojení k danému targetu/za°ízení
ze²ediví pozadí jednotlivých soubor· projektu a lze sledovat aktuální hodnoty na v²ech
vstupech/výstupech blok· a m¥nit parametry blok·. Dvojklikem na daný blok se nám
otev°e stránka s parametry, zm¥nu parametr· lze potvrdit stiskem klávesy Enter, stiskem
tla£ítka OK nebo Pouºít. Pokud nechceme zm¥ny pouºít, stiskne se tla£ítko Storno. Zob-
razení aktuálních hodnot se provádí vybráním daného bloku a zvolením poloºky menu
Target/Monitor Selection (Ctrl+W). Hodnoty se zobrazují p°ed/za vstupním/výstupním
pinem. V p°ípad¥, ºe byly v online reºimu zm¥n¥ny n¥jaké parametry, vysko£í p°i od-
pojení od targetu okno Parameter changes, kde je moºné vybrat zm¥ny, které se mají
promítnout do zdrojových .mdl soubor·.

3.3.1 Zobrazení trend·

Pr·b¥h aktuálních veli£in lze zobrazovat pomocí blok· TRND a TRNDV. Tyto bloky
slouºí pro ukládání pr·b¥h· aº £ty° pro TRND a aº 64 pro TRNDV vstupních signál·
do cyklických trendových bufer· v pam¥ti cílového za°ízení (target). Výhodou bloku
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Obrázek 3.2: Chyb¥jící licence systému REXYGEN

TRND je synchronní ukládání dat s b¥hem exekutivy reálného £asu, které umoº¬uje
ukládat do trendu i velmi rychlé signály. Na rozdíl od asynchronního ukládání dat na
nad°azeném operátorském po£íta£i (host) nedochází ke ztrát¥ n¥kterých vzork· nebo
jejich vícenásobnému uloºení. Data lze zobrazovat p°ímo z programu REXYGEN Studio a
to prostým poklikáním na bloky TRND a TRNDV v online reºimu, zobrazí se samostatné
okno, kde jsou zobrazeny pr·b¥hy daných veli£in. V trendu lze zoomovat pomocí kole£ka
my²i. Lze schovat jednotlivé pr·b¥hy v pravé £ásti okna ve stromu "Signals". Dále lze
trend zastavit pomocí tla£ítka pause nebo stop. Data z trendu lze exportovat do csv
souboru.
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Obrázek 3.3: Registra£ní formulá° pro DEMO licenci

Obrázek 3.4: Vloºení registra£ního klí£e

Obrázek 3.5: Monitorování a °ízení procesu
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Kapitola 4

Tvorba uºivatelské knihovny
funk£ních blok·

V systému REXYGEN je moºné vytvá°et opakovan¥ vyuºitelné komponenty pomocí tzv.
subsystém· v uºivatelských knihovnách. Subsystém je seskupení více funk£ních blok· a
jejich propojení. Takto seskupené funk£ní bloky se navenek chovají jako jediný funk£ní
blok. Je povoleno vno°ování subsystém·, takºe libovolný subsystém m·ºe obsahovat
dal²í subsystémy. Z libovolného subsystému je moºné vytvo°it opakovan¥ vyuºitelnou
komponentu v uºivatelské knihovn¥.

Opakovan¥ vyuºitelná komponenta v uºivatelské knihovn¥ m·ºe být vytvo°ena ve
t°ech krocích:

1. Vytvo°ení subsystému

2. Deklarace parametr· subsystému

3. P°esunutí subsystému do knihovny

4.1 Tvorba subsystému

V prost°edí REXYGEN Studio je moºné vytvo°it subsystém dv¥ma zp·soby:

• Zkopírujte funk£ní blok SubSystem z knihovny INOUT do vybraného diagramu (sou-
bor .mdl) a dvojklikem otev°ete jeho obsah pro editaci. Vloºte fuk£ní bloky podle
pot°eby, propojte je a pro vytvo°ení vstup· a výstup· pouºijte a vhodn¥ pojme-
nujte bloky Inport and Outport.

• Ozna£te skupinu funk£ních blok· a dále pouºijte p°íkaz Create subsystem (v menu
Edit→Create subsystem). Ozna£ené bloky budou nahrazeny blokem subsystému,
jeº bude obsahovat v²echny p·vodn¥ ozna£ené bloky a bloky Inport and Outport

tvo°ící rozhraní subsystému.

Výsledný subsystém obsahující funk£ní bloky a jejich propojení je zobrazen na ob-
rázku 4.1.
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Obrázek 4.1: Subsystém � seskupení funk£ních blok·

4.2 Deklarace parametr· subsystému

Typickým poºadavkem na subsystém je moºnost jeho parametrizace stejn¥ jako je to
moºné u standardního funk£ního bloku.

Za tímto ú£elem mohou být deklarovány parametry, jejichº hodnoty pak mohou být
pouºity uvnit° subsystému. Kaºdý parametr má krom¥ vlastní hodnoty také textový
popis up°es¬ující význam daného parametru.

Parametry subsystému lze deklarovat po vybrání poºadovaného subsystému a zvolení
Edit→Declaration of Parameters v menu. Na obrázku 4.2 je zobrazen dialog, pomocí
kterého se deklarují parametry subsystému a jejich textový popis.

Po deklaraci parametr· se daný subsystém chová zcela totoºn¥ jako standardní
funk£ní blok. Dvojité kliknutí na subsystém vyvolá otev°ení parametrického dialogu,
který obsahuje v²echny deklarované parametry a uºivatel m·ºe tyto parametry nastavo-
vat (viz obrázek 4.3).

Funk£ní bloky uvnit° subsystému je moºné nastavit tak, aby p°ejímaly hodnoty z
parametr· subsystému. To lze provést pomocí parametrického dialogu daného funk£-
ního bloku za²krtnutím volby Declared a zvolením poºadovaného parametru (viz obrá-
zek 4.4).

Obsah hotového subsystému s parametry je zobrazen na obrázku 4.5.
Pomocí t¥chto krok· byl vytvo°en funk£ní subsystém, který má navenek zcela totoºné

chování jako jakýkoliv standardní funk£ní blok a který je moºné libovoln¥ parametrizovat.
Pokud bude subsystém fungovat podle pot°eb, je moºné, ºe uº nebude nutné editovat
znovu jeho obsah, který z·stane navºdy skrytý. V p°ípad¥ pot°eby je samoz°ejm¥ moºné
kdykoliv otev°ít obsah subsystému a provést poºadované modi�kace pomocí volby Open
Subsystem.

Vyuºití subsystému demonstruje ukázkový p°íklad 0101-02. Ukázkové p°íklady jsou
standardní sou£ástí prost°edí REXYGEN Studio a je moºné je kdykoliv otev°ít volbou
File→Start z menu.
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Obrázek 4.2: Subsystém � Deklarace parametr· subsystému

4.3 P°esunutí subsystému do knihovny

Hotový subsystém bude pravd¥podobn¥ ºádoucí vyuºít ve více úlohách nebo projektech.
Pro tyto ú£ely zavádí REXYGEN Studio tzv. knihovny. Knihovna m·ºe obsahovat jeden
nebo více uºivatelských subsystém· pro °e²ení speci�ckých úloh. Tyto subsystémy mohou
být opakovan¥ vyuºity v libovolných projektech.

Novou knihovnu lze vytvo°it pomocí volby File→File Type. Po zvolení je otev°en
dialog, ve které je pot°eba zm¥nit typ souboru na Library.

Knihovna pak m·ºe být napln¥na libovolným po£tem subsystém·. Subsystémy je
moºné v knihovn¥ p°ímo vytvá°et nebo kopírovat z jiných soubor· pomocí techniky
�copy&paste� nebo �drag&drop� .

Po napln¥ní knihovny je nutné knihovnu uloºit do souboru v adresá°i s hlavním
projektový souborem (exekutivou). Doporu£ujeme do názvu p°idat �lib� nebo �library� ,
aby bylo kdykoliv pozd¥ji na první pohled patrné, ºe se jedná o knihovnu. P°ípona
souboru je vºdy .mdl, stejn¥ jako jakýkoliv jiný soubor vytvo°ený v prost°edí REXYGEN
Studio.

Po uzav°ení a znovuotev°ení knihovny je její pozadí obarveno sv¥tle modrou barvou
a knihovna je v reºimu pouze pro £tení. Tento reºim má zabránit náhodným necht¥ným
zm¥nám v knihovn¥. Pokud je pot°eba knihovnu upravit, je nutné ji nejprve �odemknout�
pomocí volby File→Unlock Library. Poté je moºné knihovnu libovoln¥ upravovat, je ale
nutné mít na pam¥ti, ºe provedené zm¥ny se projeví na v²ech místech, kde je daný
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Obrázek 4.3: Subsystém � Uºivatelsky de�nované parametry

Obrázek 4.4: Parametrický dialog � P°evzetí hodnoty z parametru subsystému

upravovaný subsystém pouºit (více v kapitole 5).
Poznámka 1: Subsystémy v knihovn¥ mohou být vytvo°eny jak pomocí funk£ních blok·

tak pomocí jiných subsystém· z té samé nebo libovolné jiné knihovny
Poznámka 2: V²echny soubory a knihovny pouºívající daný subsystém z knihovny

odkazují na n¥j pomocí názvu souboru a názvu subsystému uvnit° tohoto souboru. Po-
kud soubor p°ejmenujete, zru²íte v²echny tyto existující vazby. D·razn¥ doporu£ujeme
knihovnu nep°ejmenovávat. Pokud se rozhodnete knihovnu p°ejmenovat, musíte opravit
v²echna pouºití bu¤ smazáním a op¥tovným p°idáním bloku nebo ru£ní editací souboru
.mdl.
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Obrázek 4.5: Subsystém s parametry � Obsah hotového subsystému
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Kapitola 5

Pouºití subsystém· z knihovny
vytvo°ené uºivatelem

5.1 Za£len¥ní knihovny do projektu

Existující knihovnu je moºné do projektu za£lenit n¥kolika zp·soby:

1. Zkopírováním knihovny (souboru .mdl) do adresá°e s projektem.

2. Vloºením funk£ního bloku PROJECT do hlavního souboru projektu (exekutivy) a
nastavením parametru LibraryPath s názvem adresá°e, který obsahuje soubor
knihovny. Cesty mohou být absolutní nebo relativní v·£i hlavnímu souboru pro-
jektu.

3. Nastavením globálních cest ke knihovnám v nastavení REXYGEN Studio pomocí
volby Settings→Program Options. V²echny cesty zde musí být absolutní.

5.2 Pouºití funk£ních blok· z knihovny

Subsystémy resp. funk£ní bloky z knihovny se vkládají do libovolného diagramu prostým
p°etaºením z okna knihovny pomocí techniky �drag&drop� . Tím dojde k vytvo°ení tzv.
vazby mezi knihovnou a diagramem, do kterého byl funk£ní blok p°etaºen. Dále se takový
funk£ní blok pouºívá zcela totoºn¥ jako jakýkoliv jiný standardní funk£ní blok.

Vazba na knihovnu je odli²ena od standardního subsystému gra�cky pomocí horního
okraje.

Rozdíl mezi standardním subsystémem a vazbou na knihovnu je místo, které de�-
nuje obsah subsystému. Zatímco u standardního subsystému je obsah de�nován p°ímo v
souboru s diagramem, p°i vazb¥ na knihovnu je obsah subsystému de�nován v knihovn¥
a p°ípadné zm¥ny ve funkci subsystému (které je moºné provést pouze v knihovn¥)
jsou automaticky promítnuty do v²ech míst. Po úprav¥ subsystému v knihovn¥ je nutné
knihovnu uloºit a znovu na£íst v²echny soubory, které mají na tuto knihovnu vazbu
libovolným subsystémem.
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Obrázek 5.1: Standardní subsystém bez vazby a s vazbou na knihovnu

Vyuºití subsystému s vazbou na knihovnu demonstruje ukázkový p°íklad 0101-03.
Ukázkové p°íklady jsou standardní sou£ástí prost°edí REXYGEN Studio a je moºné je
kdykoliv otev°ít volbou File→Start z menu.

Note: V²echny soubory a knihovny pouºívající daný subsystém z knihovny odkazují
na n¥j pomocí názvu souboru a názvu subsystému uvnit° tohoto souboru. Pokud sou-
bor p°ejmenujete, zru²íte v²echny tyto existující vazby. D·razn¥ doporu£ujeme knihovnu
nep°ejmenovávat. Pokud se rozhodnete knihovnu p°ejmenovat, musíte opravit v²echna
pouºití bu¤ smazáním a op¥tovným p°idáním bloku nebo ru£ní editací souboru .mdl.

5.3 Zru²ení vazby na knihovnu

V n¥kterých p°ípadech m·ºe být ºádoucí vazbu na knihovnu zru²it. Zru²ení vazby trans-
formuje subsystém na standardní subsystém, jehoº obsah je de�nován p°ímo v souboru s
diagramem. Pro zru²ení vazby vyuºijte volbu Edit→Break Library Link z kontextového
menu na daném subsystému. Tím dojde ke zru²ení vazby a p°esunutí obsahu subsys-
tému do souboru s diagramem. Zm¥na se okamºit¥ projeví na zp·sobu vykreslení horního
okraje funk£ního bloku.
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Kapitola 6

Dal²í uºite£né nástroje a funkce

6.1 WebWatch vizualizace (HMI)

Dal²í moºností online monitorování a ovládání procesu je pouºití tzv. WebWatch vizu-
alizace. Jedná se o automaticky vygenerovanou HTML stránku, kterou lze spustit ve
webovém prohlíºe£i (PC, mobilní telefon £i tablet). Bloky jsou zobrazovány obdobn¥
jako v REXYGEN Studio. Zm¥na parametr· se provádí dvojklikem na daný blok, zadá-
ním nových parametr· a potvrzení tla£ítkem OK. Monitorování vstupních/výstupních
signál· se provádí kliknutím pravým tla£ítkem na poºadovaný blok.

Dal²í informace a podrobnosti o WebWatch naleznete v dokumentaci bloku HMI [1]
a v dokumentaci HMI systému REXYGEN [3].

6.2 Diagnostický nástroj REXYGEN Diagnostics

Pro pokro£ilej²í funkce vzdálené správy a sledování b¥hu algoritmu na cílovém za°ízení
slouºí nástroj REXYGEN Diagnostics. Program poskytuje detailní hierarchicky uspo°á-
dané informace o v²ech subsystémech jádra. Komunikace pomocí protokolu TCP/IP
umoº¬uje p°ipojit se k b¥ºícímu jádru na lokálním po£íta£i, v lokální síti i ve vzdálené
síti (nap°. p°es Internet).
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Obrázek 6.1: Online monitorování p°es webové rozhraní
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Kapitola 7

Klávesové zkratky
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Tabulka 7.1: Klávesové zkratky v REXYGEN Studio
Klávesová zkratka Funkce CZ Funkce EN (popis v menu)

CTRL+N Nový soubor New File
CTRL+O Otev°ít soubor Open File
CTRL+S Uloºit soubor Save File
CTRL+P Tisk Print
CTRL+SHIFT+S Uloºit jako Save as
CTRL+Z Zp¥t Undo
CTRL+Y Znovu Redo
CTRL+A Vybrat v²e Select All
CTRL+X Vyst°ihnout Cut
CTRL+C Kopírovat Copy
CTRL+V Vloºit Paste
CTRL+R Rotace bloku ve sm¥ru HR Rotate Block Clockwise
CTRL+SHIFT+R Rotace bloku proti sm¥ru HR Rotate Block Counterclockwise
CTRL+E Vlastnosti bloku Properties
CTRL+F Najít funk£ní blok Find Function Block
CTRL+M Deklarace parametr· Declaration of Parameters
CTRL+U Otev°ení subsystému Open Subsystem
CTRL+G Vytvo°ení subsystému Create Subsystem
CTRL+L Knihovna blok· Block Library
F2 P°iblíºení Zoom In
F3 Oddálení Zoom Out
F4 Výchozí zoom Zoom Default
F1 Nápov¥da Help
F5 P°eloºit schéma Compile
F6 P°eloºit a nahrát schéma Compile and Download
F7 P°ipojit se Connect
F8 Odpojit se Disconnect
F9 Aktivovat reºim Watch Activate Watch Mode
CTRL+W Monitorovat bloky Watch Selection
CTRL+SHIFT+W Vypnutí monitorování Exclude from Watch
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